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Lightroom Map Module: Advanced 

In this lesson, we’re going to take a deeper dive into Lightroom’s Map Module. Note 
that there is separate lesson where we cover the essentials, learning how to navi-
gate the module and place images on the map.

Here, I am going to show you how I research locations, get images into Lightroom 
quickly, track down the location of those images and get them on a map. Then, 
we’ll look at some of the features in Lightroom that you can use once the locations 
have been tagged. 

How to Quickly Import Images from the Internet  (Timestamp 1:00)

Whenever I research locations online, I usually am saving many location images at 
the same time. Then, I need to quickly get these location images into Lightroom. 
It’s important to note that I use a completely separate Lightroom catalog for this 
purpose. One reason for this has to do with keywords. If you download and use 
images from the Internet, these images might have keywords attached to them. In 
the case of stock photo websites, there will likely be dozens of keywords attached 
to each image. 

Whenever you import an image that has keywords attached to it, those keywords 
will be added to your keyword list (even if you remove them from the image). If 
you want to remove the keywords from your list, you can only do so one at a time. 
I keep a very organized keyword list and I don’t like outside keywords cluttering it 
up. Keeping these location images in a completely separate catalog prevents the 
keywords attached to them from getting into my main photography catalog. This 
is a personal preference. If you don’t use or care much about keywords, then this 
would not be an issue for you. 

Create Auto Import Folder Lightroom has an auto-import feature that allows for 
incoming images to be automatically placed inside a specified folder. You can then 
have Lightroom monitor that folder and automatically import any images that are 
placed inside of it. 
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Before using this feature, you’ll need to set up the folder 
you want to use. I created a folder titled “DROP,” which 
I keep on my desktop. Then, in order to quickly access 
that folder, I also placed it in the dock on the bottom of 
the screen. (On a Mac, you can store folders in the dock. 
It doesn’t move the folders on your hard drive. It just 
gives you easy access to them.) 

To place a folder in the dock, simply drag its icon into 
the dock, to the right side of the vertical line. You can 
also choose how the folder appears in the dock. Right-
click on the folder in the dock and a pop-up menu will 
appear. Here, you can choose to display the folder as a Folder icon or Stack (of 
piled images). I keep mine set to Folder. When viewing websites, you can drag an 
image from a web page and drop it directly into this folder in the dock. 

Auto Import Settings In Lightroom, you’ll need to work with some settings so that 
it knows what folder to use. Click on the File menu and choose Auto Import > Auto 
Import Settings. A dialog will appear on the screen. Make sure the “Enable Auto 
Import” check box is turned on. At the top of the dialog, there is a setting that al-
lows you to specify the “Watched Folder.” This is where you tell Lightroom what 
folder on your hard drive to monitor. Note that when choosing this folder, it needs 
to be empty to begin with. (If there is anything in the folder, it will give you an error 
message.)

ABOVE: I created a folder, titled “DROP,”  in which to place 
location images and I placed the folder in the dock. 

RIGHT: Right-click on an icon in the dock to access options 
that allow you to specify how the icon should appear. 
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Then, you will need to choose 
the destination folder. This is 
the folder that the images will 
be moved to when imported 
into Lightroom. I use the same 
folder that contains the Light-
room catalog file that I use for 
locations. Below this option, 
you will need to create a sub-
folder in which to place the 
images. Note that Lightroom 
does not let you skip this step. 
Type in the name you would 
like to use for this subfolder. 
I call mine “Shooting Loca-
tion Reference Images.” If you 
would like the images to au-
tomatically be added to one 
of your Lightroom collections, 
turn on the “Add to Collec-
tion” check box and a list of 
your collections will appear. 
Click on the collection you’d 
like to use. 

The next setting in the auto import dialog is for File Naming. You could use this if 
you’d like Lightroom to change the image file names on import. If this setting is left 
on “Filename,” it will not change the file name. 

The last category of settings allows you to choose a develop preset and specify 
what information should be attached to the images. The Metadata menu can be 
used to choose a metadata preset, which can include copyright info, file info, etc. 

Use the Auto Import Settings to specify which folder 
Lightroom should monitor. Any images moved into this 
folder will automatically be imported into Lightroom.



Lightroom Map Module: Advanced © Ben Willmore, All rights reserved 5

I like to set up a specific preset for this purpose. You can create a new preset by 
choosing “New” from the Metadata menu. The “Edit Metadata Presets” dialog will 
appear. Here, I enter “Unknown Owner” to the copyright field and include a note, 
“Do not use for any commercial purpose,” in the Usage Terms field. I name the pre-
set “Shot by Others.” Click OK to exit the Auto Import Settings dialog. 

I create a special metadata preset for location images I download from the  
Internet. This notes that the images were not shot by me and should not be 
used for commercial purposes. 



Lightroom Map Module: Advanced © Ben Willmore, All rights reserved 6

Lightroom is now set up to quickly import images moved into the folder you spec-
ified. When you find an image that you’d like to save from the Internet, drag it di-
rectly from the web page to the folder in your dock or desktop. When you do this, 
Lightroom will automatically import the image. 

Click on the image to make it active. In either the Library Module or the Map Mod-
ule, expand the Metadata Panel on the right side of the screen. Here, you can enter 
in Location/GPS data. After you enter the location info, the image will appear on 
the map. 

An image is 
being dragged 
from the web 
browser into 
the DROP  
folder in the 
dock. The  
image will  
automatically 
be imported 
into Lightroom.

The image is 
selected in 
Lightroom and 
we are pasting 
the GPS  
coordinates 
into the  
Metadata  
Panel.
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Sort Images There is one more step I take in creating this easy-import setup. In 
Lightroom’s Library Module, I click on the View menu and choose Sort > Added 
Order. This will display the images in the order in which they were added into Light-
room. This means that the last image I imported will be shown at the end of the 
image list. I like to do this because it allows me to stay in the Map Module, knowing 
that the newest images will always appear at the end (on the far right side) of the 
Filmstrip. 

Formatting of GPS coordinates (13:08)

Some location-related websites provide GPS coordinates for the images/locations. 
It’s important to know that Lightroom needs these coordinates to be in a specific 
format in order to be correctly registered in the GPS field. If you paste coordinates 
that are formatted differently from what Lightroom likes, you will get an error. 

How do we make sure that our coordinates are in the right format? By using Goo-
gle Maps. Select the coordinates and copy them to your clipboard. Then open 
Google Maps in another window. Google Maps can accept many different types of 
GPS coordinates. Paste the coordinates into the location search field and hit Enter. 
When Google finds the location, you will find that it shows the coordinates of the 
location beneath the search field. These coordinates are in the exact format that 
Lightroom needs. You can copy these and paste them into Lightroom’s GPS field 
(in the Metadata panel). 

LEFT: GPS coordinates were copied from a website. RIGHT: The coordinates were pasted into 
the Google Maps search field. The search results provide the formatting that Lightroom needs.
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Google Street View (15:51)

I find that Google Maps contains a lot of helpful tools for using maps in Lightroom. 
The Street View can be very useful because it allows you to move around and see 
a location from different angles. You can capture images of these different angles 
by taking screen shots. 

In the top left corner of the Google Street View, there is a little box with information 
inside of it. If you see an icon that looks like a clock, you can click on it to access a 
setting that allows you to see the location at different periods of time. Every time 
the Google car passed by and took pictures, they were recorded here. You can drag 
the slider to see the different points in time. This isn’t available for all locations. 

Google Street View can be useful for viewing the location at different angles. You can then 
take screen shots from various angles and add them to the Lightroom location database.
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Stacking Images When taking screen shots from various angles, I can end up with 
several shots from one location. In Lightroom, I like to keep multiple images from 
the same location in a stack. You can stack a series of images by first selecting the 
images, then right-clicking on them and choosing Stacking > Group into Stack. This 
makes it so that the Filmstrip displays only one image for each location. 

Use Filters to Ensure all Images Have Location Data (22:17)

The purpose of this shooting locations catalog is to keep track of the interesting 
places I would like to photograph one day. This requires that all of the images have 
location data so they appear on the map. I am always adding new images to this 
catalog, so I will frequently take some steps to ensure that I didn’t forget to tag any 
images. 

ABOVE: If the little clock icon appears in 
the informational box in the corner of Street 
View, it means that there are images from 
different periods of time. RIGHT: Click the 
icon to get a box that allows you to see the 
location at different periods of time.
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In the Library Module, the Filter Bar appears above the image window. If it is not 
visible on your screen, you can click on the View menu and choose “Show Filter 
Bar.” I will use a filter to limit the number of images I’m viewing based on the pa-
rameters I set up in the Filter Bar settings. 

I’ll click on the Metadata option to expand the bar to show the related filters. Each 
Metadata column allows you to filter the images based on a specified parameter. I’ll 
click on the header for the left-most column to access the menu of possible search 
parameters. If I choose to search by “GPS Data,” then that column will show me 
how many images have been tagged with GPS coordinates and how many have 
not. If I click on the “No Coordinates” results, Lightroom will filter the Grid View to 
show only the images that are not tagged with GPS coordinates. I can then manu-
ally add the location data to those images. 

Note: After using the filters, you can click the None option to return to viewing ev-
erything.

ABOVE: The Filter Bar is set to Metadata 
(circled) and we are choosing to filter images 
based on GPS data. RIGHT: The results show 
how many images are tagged with  
coordinates and how many are not.
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Copy metadata from one image to another Let’s say you have two images of the 
same location. One of the images has location info and the other does not. There is 
an easy way to copy that GPS info (or any metadata) from one image to another. 
You will need to make sure that both images are selected and that the image with 
the GPS info is MOST selected. You can tell which image is most selected because 
its thumbnail will have a brighter highlight than the rest of the selected images. 

If you have multiple images selected, simply click on the thumbnail for the image 
you would like to be most selected and it will get that brighter highlight. With more 
than one image selected in the Library Module, click the “Sync Metadata” button in 
the bottom right corner of the screen. When you do this, a dialog will appear. It will 
show you all of the metadata for the most selected image. Each piece of info will 
have a check box to the right of it. Turn on the check boxes for all of the metadata 
that you would like to sync across the selected images. If you’d like to sync all the 
metadata, click the “Check All” button in the lower left corner of the dialog. Click 
the Synchronize button to close the dialog and sync the metadata across all the 
selected images. 

The left image is not selected. The middle and right images are both selected, and the right 
image is MOST selected. The most selected image will have a brighter highlight.
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Filter Bar Options When using the Filter Bar menus 
to search images, you will notice that there are mul-
tiple location-related options. For example, there is 
a “Location” option and there is a “Map Location” 
option. This can sound a little confusing. 

Sublocation filter If you filter using the Location 
option, Lightroom is using the information entered 
into the “Sublocation” field within the Metadata 
Panel. Sometimes Lightroom automatically fills this 
field when you enter in GPS coordinates, and other times it doesn’t. That means the 
filter/search may result in many images showing up as having an “Unknown Loca-
tion.” Therefore, this search parameter can be a little unreliable. 

There are several location-related 
search options in the Filter Bar.

The Sublocation filter 
option is looking at the 
coordinating field within 
the Metadata panel. This 
field is sometimes filled in 
automatically when you 
enter GPS coordinates. 
More times than not, it’s 
left empty.
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Map Location filter When you choose the “Map Location” filter option, Lightroom 
is looking at the Saved Locations. In the Map Module, you can save locations that 
you would like to quickly access in the future. The Saved Locations Panel is on the 
left side of the module. To add a new saved location, click on the little plus icon 
to the right of the module name. A dialog will appear where you can name the lo-
cation. Use your mouse to click and drag a circle around the map area you would 
like to use for this location. You can also fine-tune the size of this circle by using 
the Radius slider within the New Location dialog. Click the Create button and the 
location will be saved within the Saved Locations panel. Click on the name of the 
location to quickly navigate the map to the area. 

In the Filter Bar, the Map Location option is looking at these saved locations that 
you have defined within the Map Module. 

ABOVE: We clicked the + icon at the top of the Saved 
Locations Panel (circled) in order to create a new 
Saved Location. The circle on the map is being used 
to define the location. RIGHT: The Map Location filter 
is looking at the locations you saved within the Map 
Module.
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City, State & Country filters The City, 
State, and Country filter options refer 
to those matching fields in the Metada-
ta Panel. When you enter GPS coordi-
nates into this panel, Lightroom can fill 
these fields in for you. You need to tell 
Lightroom to do this by clicking on the 
identity plate in the top left corner of 
the screen and turning on the “Address 
Lookup” option. 

Using Smart Collections to Create Saved Searches (34:02)

The Filter Bar is really useful for searching for images based on location, but you 
may not want to go through that process all the time. If that’s the case, you can 
automate the process by using a Smart Collection. A Smart Collection is essentially 
a saved search, where any images that meet a set of pre-defined parameters will 
automatically be placed in the collection. 

The Collections Panel can 
be found on the left side of 
Lightroom’s interface. To 
create a new Smart Col-
lection, click on the little 
plus icon ( + ) in the upper 
right corner of the panel 
and choose “Create Smart 
Collection” from the pop-
up  menu. The Smart Col-
lection dialog will appear. 
Use the field at the very 
top to name the collection. 

If you want Lightroom to automatically fill in 
the City, State & Country fields, turn on the 
Address Lookup setting.

We are clicking the plus icon at the top of the Collections 
Panel and choosing to Create Smart Collection.
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In the main part of the dialog, you can set up 
the search criteria. Click on the left-hand menu 
to access a list of search parameters. These 
are the same parameters that can be found in 
the Filter Bar, and you will see that there is an 
entire category of location-related searches. 

Let’s say that you would like to create a collec-
tion that automatically contains images shot 
in one particular state. In the video example, 
we used Georgia. (We also named the col-
lection “Georgia.”) Click on the left menu and 
choose Location > State/Province. This will 
cause a second menu to appear to the right of 
the first. Set this menu to “is.” Then, a text field 
will appear to the right of the second menu. 
Type in the state you want the collection to 
use. I typed in Georgia. This tells the collec-
tion to include images where the State field 
(in the metadata) is set to Georgia. Click the 
Create button and the collection will now ap-
pear within the Collections Panel. It will auto-
matically include all images that were shot in 
Georgia (as long as they are tagged). 

When creating a new Smart Collection, 
there are several types of location- 
related searches.

A new Smart Collection was created to include all images that were shot in Georgia.
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Other Methods for Tagging an Image with GPS Coordinates (35:25)

I already described how you can add GPS data to an image by copying the GPS co-
ordinates from a web page (or Google) and pasting them into the GPS field within 
the Metadata Panel. Let’s look at another way. 

Let’s say that the website describing the location only lists the address, and not the 
GPS coordinates. In that case, copy the address and paste it into the search field in 
the top right corner of the Map Module. Tap the Enter key and Lightroom will try 
to find the location. If it does find the location, it will navigate to that address on 
the map. 

Often times, however, Lightroom has trouble finding the exact location. If the ad-
dress you paste is not in the exact format that Lightroom likes, it will run into an 
error. Make sure that there is a comma and a single space after the street name and 
before the city name. 

If Lightroom still can not find the location, you’ll have to do the following. Copy the 
address and then open Google Maps (maps.google.com). Paste the address into 
the search field and hit Enter. Google will navigate the map to the location. Because 
you typed in an address, however, the search results will not display the GPS coor-
dinates. Use your mouse to click in an empty map area just outside the location pin 
for the address you searched. A little informational box will pop up. This box does 
contain the GPS coordinates, but they are not in the format that Lightroom likes. 

ABOVE: An address is copied from a 
website. RIGHT: We searched the ad-
dress in Google Maps and clicked just 
outside the location in order to get the 
informational box shown below.
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Click on those coordinates and the information will expand to be displayed in the 
panel on the left side of the screen. Here, the GPS coordinates appear again and 
they are now in the correct format. You can copy and paste them into Lightroom. 

NOTE: If you click in an empty map area and no informational box appears, you 
can instead right-click on the area. A pop-up menu will appear. Choose the “What’s 
here?” option. This will force the map to add a pin and present the informational 
box. 

Another useful tool is the little yellow person icon in the bottom right corner of the 
Google Maps interface. If you click and drag the little person over the map, you will 
see blue lines appear. These lines indicate where the Google Maps cars have trav-
eled with cameras and taken pictures of the surroundings. 

We clicked on the address that shows up in the info box (left) and the info is expanded 
(right) on the left side of the screen. The coordinates shown here are in the format that 
Lightroom likes.

The little yellow 
person icon is 
being placed on 
the map.
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As you move the little yellow person somewhere on the map, pay attention to the 
little green circle that appears over the blue line. This is where Google will place the 
person when you release the mouse button. When you place the person, Google 
Maps will switch to Street View and show you the images shot from that location. 
You can click to move around the area in this view. Here, you can capture screen 
shots that you can use in the Lightroom location database. 

In the lower right corner of this street view, you will often times find little plus and 
minus buttons. These can be used to zoom in and out on an area. This can be useful 
if you want to get a higher resolution image of the location. 

After the little person was placed on the map, it switches to street view, showing you the im-
ages shot by Google from that location.



Lightroom Map Module: Advanced © Ben Willmore, All rights reserved 19

Find a Location with only City, State Info (41:25)

There are some instances where I’ll find a picture of a location that I want to pho-
tograph, but the only location info available is the state and town name. If this is 
the case, you can still paste that info into Google Maps to see a more generalized 
location on the map. 

Here, you can do some investigative work. Enter the Satellite View in Google Maps 
and then examine the picture you have of the location. How big is the building? Is 
it on a street corner? Does it have a large parking lot? Are there surrounding build-
ings? Zoom in and scan the map area to see if you can find the location. This will 
obviously be easier if the place is located in a smaller town. If you think you found 
the location, drag that little yellow person icon into the map in order to view the 
location in Street View. Here, you can move the view around to confirm that you’ve 
found the correct location. 

We only had city/state info for an image so we are viewing the city (town) in the Google 
Maps Satellite View. At left is the entire town. At right, we zoomed in to find the location 
based on info we gathered from the reference picture. 
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If you’re in the Street View and would like to return to the map view, click on the 
back arrow that appears in the little informational box in the upper left corner of 
the screen. Be careful though! Sometimes, when you do this, it will return the map 
to the entire city view and you will no longer be able to get precise GPS coordi-
nates. Before clicking the back arrow, copy the street address that appears in that 
box. This will ensure that you have the precise location. Then, click the back arrow. 
If it happens to zoom out on the entire town view, simply paste that address back 
into the search field so that you can access the precise GPS coordinates. 

After searching for a location on Google Maps, there may be more than one search 
result. If that’s the case, you can click through the various search results to see im-
ages of each location. This can help you to determine which result is the location 
you’re looking for. 

LEFT: We are placing the little yellow person icon in the location we want to view. RIGHT: Af-
ter placing the person, Google enters Street View and we can confirm that this is the location 
that matches the image.

The back arrow (circled) will take you back 
to the map view. Before clicking this, copy 
the address in case you need to paste it back 
into the search field.
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Another Way to Access Website Images (49:11)

There may be instances where you find a photo of a location that you’d like to save, 
but when you drag the image to the folder on your desktop, it just doesn’t move. If 
this happens, you COULD take a screen shot, but this can sometimes be less than 
ideal (especially if there is something overlaid on the image). 

If you happen to use the Safari web browser, there is a trick for accessing the image 
another way. In order to do this, you will need the “Develop” option to appear in 
Safari’s main menu. This can be set up in the Preferences. Click on the Safari menu 
at the top of the screen and choose Preferences. In the Preferences dialog, click 
on the Advanced tab. Different settings will appear. Turn on the check box at the 
bottom that reads “Show Develop menu in menu bar.” Know that the options in this 
menu are designed for people who write websites. 

Now that you have the Develop menu visible, click on it and choose “Show Page 
Resources.” A list of resources will appear on the left side of the screen. Click on the 
Images folder and a list of images that appear on the web page will appear. Here, 
you can access the location image you need. 

We clicked on the Develop menu and chose “Show Page Resources.” We chose “Images” from 
the options at left and a list of the images used on the web page appears.
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Remove Keywords in Lightroom (52:06)

When you take images from the Internet and import them into Lightroom, many of 
them will likely have keywords attached to them. I, personally, do not want other 
people’s keywords in my Lightroom catalog so I will remove them. To remove key-
words from a series of image, first select all of the images in the Library module. 
Then, expand the Keywording Panel on the right side of the screen. This panel con-
tains a text field with all of the keywords from the selected images. Simply select 
all of the text in this field and hit the Delete key. 

All of the images are selected in the Library Module. We selected all of the text in the  
Keywording panel and are about to tap the delete key to remove the keywords.



Lightroom Map Module: Advanced © Ben Willmore, All rights reserved 23

Useful Plug-Ins (53:00)

Plug-ins provide ways of extending what Lightroom is capable of when it comes to 
locations. There are two plugins that I really like. The first allows you to customize 
the Metadata Panel.

Metadata Preset Plugin The Metadata Panel is 
located on the right side of Lightroom’s Library 
Module and there are ways of customizing what 
appears within this panel. Click on the menu at the 
top of the panel and you will find several options 
for types of metadata that can be displayed. “Lo-
cation” is one of these options. When you choose 
one of these options, the panel will show a pre-se-
lected group of informational fields. Often times, 
the panel is still showing fields that I never use. 
Also, there may be a field that I DO use but it 
doesn’t appear in the panel. 

There is a plug-in that will allow you to cre-
ate custom presets for the Metadata Panel, 
allowing you to determine exactly which info 
fields appear in the panel. It’s called “jf Meta-
data Presets.” 

To create a metadata preset using this plug-
in, click on the File menu and choose Plug-
in Manager. A window will appear and the 
left side will show all plug-ins that have been 
added to Lightroom. Click on the name of the 
plug-in, “jf Metadata Presets,” and the preset 
info will appear in the main window. Click on 
the “Configure Metadata-View Presets” but-
ton. This will bring up another window that 
will allow you to customize the panel. 

The menu at the top of the  
Metadata Panel allows you to 
choose what types of info fields 
are visible in the panel.

We selected the Metadata Presets 
plug-in from the left side of the Plug-In 
Manager and are clicking the Configure 
button in order to create a preset.
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The left side of the window contains a view of the Metadata Panel and you can click 
the arrow to the left of a field name to make it active. Then, you can use the buttons 
below the panel to move the field up or down in the panel. You can also tap the 
Delete button to remove the field. This will not remove the metadata information. 
It will simply remove the field from view. 

The right side of the window contains a list of all the metadata fields that are avail-
able in Lightroom. Click on any of these items and it will be placed in the panel on 
the left. 

After you have customized the panel, click the Save button in the upper left in 
order to save this panel setup as a preset. You’ll be prompted to give the preset a 
name. Close this window to return to the Plug-In Manager window. Here, you will 
need to click the “Reload Plugin” button in order for the changes to take effect. 

After you’ve done this, your new preset will appear within the menu at the top of 
the Metadata Panel. 

The Metadata  
Presets plug-in is 
being used to add 
and remove info 
fields from the  
panel in order to 
create a custom 
preset.
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Geocoding Support Plug-in 
The next plugin I use for loca-
tion info is called “jf Geocod-
ing Support” and it provides a 
lot of useful tools for working 
with locations. After the plug-
in has been installed, these 
tools can be accessed by 
clicking on the File menu and 
choosing Plug-in Extras. This 
will expand a menu to show 
an entire category of Geoc-
oding Support options. Many 
of these options allow you to 
quickly view the location of 
the active images in websites 
like Google Maps, Flickr, etc. 
One of the options I really like 
is called “Full Catalog Proximity Search.” This will search the entire Lightroom cata-
log for other images that have nearby location tags. I like this because it allows me 
to see other good shooting locations that are close to the one I’m planning to visit. 

Great websites for finding interesting things to photograph:

www.waymarking.com 

www.roadsideamerica.com 

Plug-in websites (These pages include installation instructions.):

Metadata Presets Plug-in: http://regex.info/blog/lightroom-goodies/metadata-presets

Geocoding Support Plug-in: http://regex.info/blog/lightroom-goodies/gps

Access the Geocoding Support options by clicking on the 
File menu and choosing Plug-In Extras.

http://www.waymarking.com  
http://www.roadsideamerica.com  
http://regex.info/blog/lightroom-goodies/metadata-presets
http://regex.info/blog/lightroom-goodies/gps

